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Important Announcement

The information contained in this document is the property of ATOP Technologies, Inc., and is supplied for the sole purpose
of operation and maintenance of ATOP Technologies, Inc., products.

No part of this publication is to be used for any other purposes, and it is not to be reproduced, copied, disclosed, transmitted,
stored in a retrieval system, or translated into any human or computer language, in any form, by any means, in whole or in part,
without the prior explicit written consent of ATOP Technologies, Inc.,

Offenders will be held liable for damages and prosecution.

All rights, including rights created by patent grant or registration of a utility model or design, are reserved.

Disclaimer

We have checked the contents of this manual for agreement with the hardware and the software described. Since deviations
cannot be precluded entirely, we cannot guarantee full agreement. However, the data in this manual is reviewed regularly and
any necessary corrections will be included in subsequent editions.

Suggestions for improvement are welcome. All other product’s names referenced herein are registered trademarks of their
respective companies.

Who Should Use This User Manual

This manual is to be used by qualified network personnel or support technicians who are familiar with network operations, and
might be useful for system programmers or network planners as well. This manual also provides helpful and handy information
for first time users. For any related problems, please contact your local distributor. If they are unable to assist you, please
redirect your inquiries to www.atoponline.com .

Warranty Period

There is no warranty for the software. Please rely to the license agreement.
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1 Introduction

11 Purpose of the Manual

This manual explains the available technical features of the Network Management Utility. During the device configuration,
users can follow instructions, examples, and guidelines provided in the manual for a general and advanced network
management. Some general technical information is also given to help users manage their devices. A background in general
theory is necessary when reading it. Please refer to the Glossary for technical terms and abbreviations.

1.2 Who Should Use This User Manual

This manual should be used by qualified network personnel or support technicians who are familiar with network operations.
It can be useful for system programmers and network planners. This manual will also come handy for new users. If there are
any issues, please reach us at www.atoponline.com.

1.3 Scope

Network Management Utility is a software utility developed by ATOP Technologies. It is a special tool for device
management and configuration of our products. It can be used for daily management and setting tasks on various Atop’s
network devices such as:
e  Device discovery and listing
e  Device grouping
e  Login with password
Network parameter configuration
Firmware update
Reset to Default
Backup and restore configuration

14 System Requirements

Windows 7/8

Windows 2008

Windows Vista

Windows Professional 2003

Windows 2000/Windows NT

Windows 10 is supported and fully functional; however, some issues related to font-size have been reported.

Note: All figures herein are intended for the illustration purpose only. Certain features of this software work only on
some specific ATOP devices.
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2 Getting Started

1.1 Installation of Network Management Utility

The Network Management Utility can be either installed from the CD that comes in your product package or can be
downloaded from www.atoponline.com. Once the installer is available on your PC, proceed to install it by double clicking on
the Network Management Utility program icon which has the icon as shown in Figure 2.1.

I
S
Metwork
Management

Ltility Setup
2.0.7.exe

Figure 2.1 Network Management Utility©® Program Icon

For Windows 7 users, it is strongly recommended to allow the program to run in the Compatibility Mode. This can be done by
right clicking the Network Management Utility Setup 2.X program icon and selecting the Properties menu as shown in
Figure 2.2. Then, click on the Compatibility tab and tick on the “Run this program in compatibility mode for:” box and
tick on the “Run this program as an administrator” box, as shown in Figure 2.3. Finally, click OK button and proceed to
install the program.

Open
Run as adrninistrator

Troubleshoot compatibility

Run with graphics processor >
Pin to Start

7-Zip »
CRC SHA >
Scan with Windows Defender...

Share

Give access to b

Pin to taskbar

Restore previous versions

Send to b

Cut
Copy

Create shortcut
Delete

Rename

Properties

Page 9 of 59


http://www.atoponline.com/

gaaR! B [ H] K518 Heading
Network Management Utility User Manual 1,Product Manual ZH B ZEE TR

REUREYSLF ©

Figure 2.2 Right Click the Network Management Utility© Program Icon

EE Network Management Utility Setup 2.0.6 Properties *

General Compatibility Security Details Previous Versions

Ifthis program isn't working correctly on this version of Windows, try
running the compatibility troubleshooter.

| Run compatibility troubleshooter

How do | choose compatibility settings manually?

&
aele Compatibility mode
Network Run this program in compatibility mode for:
Manageme...
Windows 8 w
Settings

[ JReduced colour mode

8-bit (256) colour
[ ]Run in 640 x 480 screen resolution
D Disable full-screen optimisations

Run this program as an administrator

Change high DPI settings

GChange settings for all users

0K Cancel Apply

Figure 2.3 Right Click Properties > Compatibility Tab - Tick Two Boxes

1.2 Installation

Click the OK button in setup program’s properties as shown above. Then, after double click on the setup icon, a pop-up window
will be launched, as shown in Figure 2.4. After finishing it, the Network Management Utility Setup program is installed into
your computer system.

o
LiCA

Network
Manageme..

:‘_,.'E Instaling, please wait...

L

Figure 2.4 An Installing Pop-up Window
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3 User Interface

Double click already installed Network Management Utility Setup 2.X to launch the program. While loading the program,
its logo and version appear as shown in Figure 3.1 below.

at p Network Management
Utility

Technologies

v2.1.1

Figure 3.1 Lunching when Double Click the Network Management Utility Setup

The user interface (Ul) of Network Management Utility Setup 2.X is depicted in Figure 3.2. The window consists of the
followings: 1) pull-down menus at the top, 2) a vertical left menu, and 3) a working space in the middle of the window. When
users click at a vertical left menu, an icon bar (at the second top horizontal layout) will appear for the Device List and Topology

menus. The following chapters will describe each item and its function in details. Here, how to first discover the connected
devices will be explained.

E% Network Management Utility
File View Help

Group View

No Data

Figure 3.2 First-time Launch of Network Management Utility Setup 2.X

Clicking on the discovery icon at the top icon bar. It will show number of connected devices to the Network Management

Utility Setup 2.X, as shown in Figure 3.3. If these devices are still not grouped together, number of devices will be showed as
unGrouped.

[ Network Management Utility - [m] X
File View Help

> 0 T < 9 6/

;

unGrouped (1 devices) v

Group View

Figure 3.3 Working Space after Clicking on Discovery lcon
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Click on the drop-down icon on the right, and the list of the found device(s) is displayed as table with the following columns:
Online, Device Type, Model, IP Address, MAC Address, Host Name, Kernel, AP, and Access as shown in Figure 3.4.
When users click at the head of the column, the devices are sorted according to values of devices in that column.

[E Network Management Utility - o X

File View Help

< O T < H 6 8 Group View

£ Device List

& Event Log unGrouped (1 devices) -

% Ty a x|

You have to join it in any group first
for access.

Basic 05202 10.0.50.1 00:60:E9:21:85:3E System 118 05202 V118 X

1-10f 1 items ‘ 1 ‘ 10 / page Goto

Figure 3.4 List of Connected Devices after Clicking Discover Icon

The first column called Online shows the status of each device: active (green dot) or inactive (red dot). The second column
called Device Type, shows whether it is a basic or an advanced device. The third column is the Model number of the found
device(s). The fourth column is the IP Address of the corresponding device. The fifth column is the MAC Address of the
device. The sixth column is the Host Name of the device. The seventh column is the Kernel version of the device. The eighth
column is the AP information or application version of the device. Note that Atop’s firmware of a device generally consists
of application version and kernel version. The last column, Access, indicates whether the device is already accessible ( v ) or
not ( % ). Users have to join the device in any group first for its accessibility. That is users have to create a group and add the
device to that group first to view it as accessible.
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4 Top Drop-down Menus

There are three menus on the drop-down menu: File, View, and Help. In the following sections, each sub-menus within each
menu are described in details.

4.1 File
The first menu on the pull-down menus is the File, as shown in Figure 4.1. In this menu, there are four submenus:
e  Preference...
e Import Settings...
e  Export Settings...
e Quit
B} Network Management Utility - [m] ®
File View Help
Preference... Ctri+P
Import Settings. . tr DT <L D O R ) Group View
Export Settings...
Quit
Group A (1 devices) ~
O search  x
Model IP Address MAC Address Hostname Kernel Ap Access
. Basic 105202 10.0.50.100 00:60:E9:21:85:3E System 118 105202 V1.18 v
1-1 of 1 items I 1 ‘ 10/ page Goto

unGrouped (0 devices)

Figure 4.1 Submenus within File Menu

4.1.1 Preference
As shown in Figure 4.2 below, four sub-menus are contained within the Preference sub-menu under File menu: General,
Mail, SNMP, and Advanced.

R Network Management Utility

File View Help

* Preferences

General
Network Interface Card
Mail
default - 0.0.0.0
SNMP
Advanced

Figure 4.2 File > Preference Sub-menu
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4.1.2 General Sub-left menu

In this File > Preference Sub-menu - General Sub-left menu, the Network Interface Card are displayed. Here, all
interfaces are listed including virtual interface, As shown in Figure 4.3 below.

% Network Management Utility = o x
File View Help

Q Preferences

General
Network Interface Card
Mail
{ default - 0.0.0.0
SNMP
default - 0.0.0.0
Advanced Microsoft Wi-Fi Direct Virtual Adapter - 0.0.0.0

Microsoft Wi-Fi Direct Virtual Adapter #2 - 0.0.0.0
Intel(R) Ethernet Connection (3) 1218-LM - 10.0.50.101

Intel(R) Dual Band Wireless-N 7265 - 192.168.1.39

Figure 4.3 File - Preference Sub-menu - General Sub-left Menu

4.1.3 Mail Sub-left Menu
In this File > Preference Sub-menu - Mail Section, users can enable automatic sent-mail notification, as shown in Figure

4.4 below. Click 1 EnableNotification tg toggle Enable Notification to enable the service, such as Gmail, Hotmail, Yahoo.
Select option Mail Service List if using mail service from available standard provider; otherwise, select User Definition and
enter your choice of host mail and port.

3 Network Management Utility = =] X
g
File View Help

General Mail Service

Mail
1 Enable Notification

SNMP
(&) Mail Service List Gmail

Advanced
(O user Definition

Mail Settings

Mail Username

Password ®©
To:

[+ + New Mail

- + New Mail

Figure 4.4 File - Preference Sub-menu - Mail Sub-left Menu
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Users have many choices of mail services, as shown in Figure 4.5 below.

e (== | [oma |[omt -]

a  SES-US-EAST-1 “

126 - Gmail “  Mailru ~  Outlook365 “  SES
. Godaddy Maildey Postmark Che U EAST SES-US-WEST-2
Tund? GodaddyAsia I Mailgun aa S USWEST SES-EU-WEST-1
- AOL GodaddyEurope . Mailjet QQex SES-FU-WEST-1 Sparkpost
DebugMiail hot.ee Mailosaur I SendCloud Sparkpost Yahoo
DynectEmail Hotmail Mandrill SendGrid I Yahoo [ Yandex
FastMail iCloud Naver SendinBlue Vandex Zoho
GandiMail . mailes OpenMailBox - SendPulse - Zoho -~ giyealiyun -

Figure 4.5 List of Mail Services Available within File - Preference Sub-menu = Mail Sub-left Menu

Click to enter valid email address of each email header: To:, CC:, and BCC..

4.1.4 SNMP Sub-left Menu

In this File > Preference Sub-menu > SNMP Sub-left Menu, users can enable SMNP service and configure setting such as
SNMP Scan, Default Community, and Others, as shown in below.

B Network Management Utility 2 a X
File View Heip

SNMP Scan
General
Mail 1 Enable
SNMP
Advanced > IP Range List

SNMP Polling Interval 30 min
ICMP Timeout 2000 m

SNMP Timeout 3000 m
Default Community

SNMP Version
public
private

Others

1 Precheck device SNMP feature before specific operate.

Figure 4.6 List of SNMP Scan Sub-section Available within File > Preference Sub-menu > SNMP

In File & Preference Sub-menu = SNMP Sub-left Menu, toggle ™ Enable g enable SNMP scan and click FEREET to
add range of IP addresses in IP Range List, as shown in below.
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Add New IP Range

Enable

nd IP Address

10.0.50.101 - 10.0.50.200

Vv IP Range List

De less then end address and In the same network segment

10.0.50.101 - 10.0.50.200 X

Figure 4.7 SNMP Scan Sub-section within File = Preference Sub-menu = SNMP Sub-left Menu

Please refer to Section 4.1.4 if an SNMP function is not enabled. That is if the software continues notifying that “(This feature
only for device with SNMP support.)” and the “OK” link cannot be clicked even user already enabled an SNMP function via
the Network Management Utility Setup 2.X. User should enable an SNMP function via web interface of the device instead.
User can follow the instruction in Section 0 to initialize a web configuration page. Note that when the SNMP is enabled, the
device type changes from Basic to Basic/SNMP.

Bas :Sl‘“ﬁ Vanaged Switch, EHG7508-8PoE 10.0.50.1 00:60:E9:19:53:8B EHGT508 3 3.1 v

Figure 4.8 Device Type is shown as Basic/SNMP

The description of each field in the File-Preference-SNMP Sub-left Menu-SNMP Scan section is shown in Table 4.1.
Table 4.1 Description of each field in the File-Preference-SNMP Sub-left Menu-SNMP Scan Section

Field Name Description Default
Value
IP Range List A start and end IP addresses of devices to scan SNMP message N/A
SNMP  Polling | The period of time between the end of the timeout period of the last polling, where polling
Interval consists of launching remote queries synchronously, either actively or on demand. 30 mins
ICMP Timeout The maximum number of milliseconds before a ICMP response is received 2000 ms
SNMP Timeout | The maximum number of milliseconds before a SNMP response is received 3000 ms

In File > Preference Sub-menu - SNMP Sub-left Menu, users can set Default Community, as shown in Figure 4.9 below.

SNMP Version v2¢
public

private

Figure 4.9 Default Community Sub-section within File - Preference Sub-menu - SNMP Sub-left Menu

The description of each field in the File-Preference-SNMP Sub-left Menu-Default Community section is shown in 4.2 below.
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Table 4.2 Description of each field in the File-Preference-SNMP Sub-left Menu-Default Community Section

Field Name Description Default
Value
SNMP Version Version of SNMP available on SNMPv1 and SNMPv2c (with data encryption) v2C
Read Community Community string (in clear text) allows access to a device and read its statistics public
Write Community | Community string (in clear text) allows access to a device and write its statistics (or private
edit its configurations)

To make the device’s information available for public viewing/editing, you can enable the SNMP function by toggling the
Enable option and fill in the two passphrases (or SNMP Community Strings) below it. By filling in the passphrase for the
“Read Community”, the connected device allows other network management software to read its information. By filling in
the passphrase for the “Write Community”, the connected device allows other network management software to read/modify

its information. The default device’s SNMP Community Strings (or passphrases) for Read Community and Write
Community are “public” and “private”, respectively.

In File > Preference Sub-menu - SNMP Sub-left Menu - Others section, users can precheck device SNMP feature before
some specific operations in the Others section, as shown in Figure 4.10 below.

10 Precheck device SNMP feature before specific operate.

Figure 4.10 Others Sub-section within File > Preference Sub-menu - SNMP Sub-left Menu

When performing some specific setting such as network setting, the program will precheck device SNMP feature first as shown
in Figure 4.11 below.

Network Management Utility
File View Help

— Checking SNMP feature...

Figure 4.11 Precheck Device SNMP Feature First before Specific Operations
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4.2 View

The second menu on the pull-down menus is the View, as shown in Figure 4.12. In this menu, there is one submenu:
e Toggle to full screen

% Network Management Utility - o X

File View Help

Toggle Full Screen F11

¢ (:) t < O Lt ;p* Group View
£ Device List
[E EventLog GrOUp A (1 devices) o
< Topology unGrouped (0 devices)

Figure 4.12 Toggle Full Screen Submenus within View Menu

When selecting Toggle to Full Screen or press F11 button, the window will expand to full. When re-selecting it or press F11
button again, the window will be minimized to the original size.

4.3 Help

The third menu on the pull-down menus is the Help, as shown in Figure 4.13. In this menu, there is one submenu:
e  About Network Management Utility

# Network Management Utility - o x

File View Help

About Network Management Utility

< ) T <: H O & Group View
R Device List
B Event Log Group A (1 devices) -
o Topology |O\7x
Basic 05202 10.0.50.100 00:60:E9:21:85:3E System 1.18 05202 V1.18 v
1-1 of 1 items ‘_‘ 10/ page Goto

unGrouped (0 devices)

Figure 4.13 About Network Management Utility Submenus within Help Menu

When selecting About Network Management, logo and version of the software appear, as shown in Figure 4.14 below.
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f3 Network Management Utility - o X

File View Help

Network Management Utility v2.0.7

CLOSE

Figure 4.14 About Network Management Utility Window
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5 Side Vertical Menus

Side Vertical Menus consists of the followings, as shown in Figure 5.1:
e Deuvice List

e EventLog
e Topology
! EE Network Management Utility — O x
File View Help
< (:) T '1: H O Group View
Q X
E X

1of 1items 10 / page

Figure 5.1 Side Verticle Menus

51 Device List

In the Side Vertical Menus—> Device List, it consists of

1) a device table in each device group’s working space and

2) the top horizontal icon bar. In this section, only the first part will be described. Details of the second part will be
explained in Chapter 6.

In the Side Vertical Menus—> Device List, connected devices are listed here according to its group. If any devices were not
added to any grouped, these devices will be listed in the unGrouped section as shown in Figure 5.2. As described in Section 3,
the list of the found device(s) is displayed as table with the following columns: Online, Device Type, Model, IP Address,
MAC Address, Host Name, Kernel, Ap, and Access. When users click at the head of the column, the devices are sorted
according to values of devices in that column.
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% Network Management Utility - ] X
File View Help
< (:) T < O [+ ;2 Group View
P Device List

B Fvent Log unGrouped (1 devices) -

< Topology |§‘

You have to join it in any group first
for access.

Basic 05202 10.0.50.100 00:60:E9:21:89:3E System 1.18 05202'V1.18 X

1-1 of 1 items ‘ 1 ‘ 10 / page Goto

Figure 5.2 List of Connected Devices in Side Vertical Menus - Device List

The description of each field in the Side Icon Menu->Device List is shown in Table 5.1 below.

Table 5.1 Description of each field in the Side Icon Menu > Device List

Field Name Description

Online Indicate the status of each device: active (green dot) or inactive (red dot).

Device Type Indicate whether it is a basic or an advanced device

Model Model number of the found device(s)

IP Address The IP Address of the corresponding device

MAC Address MAC Address of the device

Host Name Host Name of the device

Kernel Kernel version of the device

AP Information Application version of the device

Access Indicate whether the device is already accessible ( v ) or not (). Users have to
create a group and add the device to that group first to view it as accessible.

In this File > Preference Sub-menu > SNMP Sub-left Menu, users can enable SMNP service and configure setting such as
SNMP Scan, Default Community, and Others.

5.2 Add New Group

As mentioned in Chapter 3, when user would like to access the device, user has to add the device into the group first. To
create/add a new group, user can click at Add New Group icon on top horizontal icon bar. A new small box will appear to let
user enter a group name, as shown in Figure 5.3. After entering a group name, click APPLY button.
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8 Network Management Utility - [m] X
> f:J Y < H O }:Q . Group View
Enter a name.
Group u (2 uevices) ~

Online Device Type Model IP Address MAC Address Hostname Kernel Ap Access
. Basic/SNMP Managed Switch, EHG7508-8PoE 10.0.50.101 00:60:E9:19:53:8B 3 3 v
N/A 00:60:E9:19:53:8E v

1-2 of 2 items 10 / page Goto

Figure 5.3 Click Add New Group Icon in the Top Horizontal Icon Bar

If the new group is successfully created, the notification window will be launched showing the success message, as shown in
Figure 5.4.

[E# Network Management Utility

File View Help

Success!

Add new group successful.

Figure 5.4 Success Window after Successfully Added a New Group

5.3 Group View (Toggle Icon)

On the most right, there is a toggle menu — ®®*PV'* called Group View. If user enables it, it will show active devices in

a group view. If not, all connected devices will be displayed in the same working area without classifying them into groups.
Figure 5.5-(a) shows a list of devices without classifying it in a group, while Figure 5.5-(b) shows a list of devices in a group.
Note that devices have to be added into a group first before; otherwise,

connected devices will be listed in an unGrouped section.
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K3 Network Management Utility — a %
File View Help
> [ * < H O ;9 Group View
Group A (1 devices) ~
Q X
v
Group B (2 devices) ~
Q X
v
v
(a)
[# Network Management Utility - X
File View Help
> (:) T < H O Group View
¥l
- a X
<@

9:53:8B 3.1 3.1

1-2 of 2 items ‘ 1 ‘ 10/ page Goto

(b)
Figure 5.5 A List of Devices () in grouping (b) without Classifying in a Group

5.4 Edit groups

In the working space of the device list, if users right click on the area outside the table of device list but still inside a group or
right click on any group after minimizing a device list, it will show the following menus: Edit Group Name, Remove Group,
and Edit Member, as shown in Figure 5.6. Note that this function is not active in section of upGrouped devices.
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Network Management Utility - a X
File View Help
< (:) T ‘<: LONN +1 & Group View

£ Device List

El Event Log Group A (1 devices) ~

< Topology Q, X

‘ Basic 105202 10.0.50.100 00:60-E9:21:85:3E System 118 105202 V1.18 v

1-1 of 1 items D 10 / page Goto

/#  Edit Group Name
B Remove Group
i

unGrouped (0 devices) Edit Member

Figure 5.6 Right Click on any Space in a Group but outside the Device Table

5.4.1 Edit Group Name

When a user clicks on Edit Group Name, a small new window is launched, as shown in Figure 5.7. User can input a new
group name and then click APPLY button for it to take effect.

Enter a new name.

Figure 5.7 Enter a New Name Window

5.4.2 Remove Group

When a user clicks on Remove Group, a small new window is popped up. User needs to click an OK button to confirm the
request, as shown in Figure 5.8.

Confirm

This will remove the group.

Figure 5.8 Confirmation Dialog for User to Remove a Group

When the selected group is successfully removed, the new window is initialized to notify its success, as show in Figure 5.9
below.
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Success!

| | Remove group successful.

Figure 5.9 Confirmation on Sucessfully Removing a Group

5.4.3 Edit Member

When a user clicks on Edit Member, a new Group X - Edit Group Member window is launched. User needs to select devices
that are wanted to be added in the Group x (Group A in this example), and click > Add Member button to move devices from
the left sub-window into the right sub-window, as shown in Figure 5.10. Note here that one device can be added into more than
one group.
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R Group A - Edit Group Member X
1/1 item Non Member 0 item Member
EHG7508 236.67.1.0 00:60:E9:19:53:8B

APPLY

Figure 5.10 Add Member to the Selected Group

If user would like to remove any devices from the selected group (Group A in this example), user needs to click on devices
that are wanted to be removed, and click < Remove Member button to move devices from the right sub-window into the left
sub-window, as shown in Figure 5.11.

,Q_._ Group A - Edit Group Member X

0 item Non Member 1/1 item Member

EHG7508 236.67.1.0 00:60:£9:19:53:8B

< Remove Member

APPLY

Figure 5.11 Remove Member from the Selected Group

After clicking APPLY button, the Edit Group Member window is closed and devices in Group A are shown in the device
list. A small notification window for Device Online appears on the bottom right corner, as shown in Figure 5.12.

Page 26 of 59



$EaR! (EH [% H] %5 [#R8+ Heading

Network Management Utility User Manual 1,Product Manual ZH B ZEE TR
REURAY L ©
B Network Management Utility — [m] e
File View Help
> (:) T < H O 83, Group View
Group A (1 devices) ~
1o X

Basic EHG7508  236.67.1.0 00:60:E9:19:53:8B EHG7508 3N EHG7508-8PoE Application: V3.11 v

1-1 of 1 items

# Device online

EHG7508
P ad:

unGrouped (0 devices)

Figure 5.12 Devices Added/Removed to/from Group A

5.5 Perform actions on devices assigned to groups

With a right click on the list of devices in any group, the drop-down menu appears as shown in Figure 5.13 below: Open Web,
Telnet, Beep, Reboot, Network Setting, Device Advanced Setting, Port Information, and Backup and Restore. Note that
if the connected device is not added into a group, this right click feature is not functional.

% Network Management Utility - [m] x
File View Help
< (:) T < O [+ f(}‘l Group View
£ Device List
El Eventlog Group A (1 devices) -~
% Topology ‘O\ %

Basic 05202 10.0.50.100 00:60:E9:21:85:3E System 1.18 05202 V118 v

Open Web > 1-1 of 1 items ‘7‘

Telnet —

10 / page Goto

Beep
unGrouped (0 devices) Reboot

Network Setting

Device Advanced Setting

Port Information

DYIBAOILAB

Backup And Restore

Figure 5.13 Drop-down Menu when Right Click on the Device List in any Group
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55.1 Open Web

Selecting Open Web - Open on OS browser will initiate configuration of the device through web-based, as shown in Figure
5.14. User will be prompt with username and password to login, as shown in Figure 5.15. The default username and password
are “admin” and “default”.

i Network Management Utility _ = «
File View Help

> DT L H O B Group View

Je)
& Group A (1 devices) ~

A
5
X

Basic 05202 10.0.50.100 00:60:E9:21:85:3E System 1.18 05202 V1.18 v

Clzam WED > [ Openon OS browser ‘*|
ns

10 / page Goto
BED Openon NUM —

Telnet

Beep

Reboot

Network Setting

Device Advanced Setting

Port Information

PRXBAOINAS

Backup And Restore

Figure 5.14 Drop-down Menu, Right Click, Device List in any Group, Open Web - Open on OS browser

B «El 9 10.0.50.100 X [+ i

X @ & 10.0.50.100/

Windows Security X
Microsoft Edge

The server 10.0.50.100 is asking for your username and password.
That server also reports: "GoAhead".

Warning: Your username and password will be sent using basic
authentication on a connection that isn't secure.

| admin ‘

oK Cancel

Figure 5.15 Login to Web-based Configuration

Selecting Open Web - Open on NUM will initiate web configuration of the device through NUM, as shown in Figure 5.16.
Click = to close the web configuration and return to working space of the device list.
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HH Network Management Utility

File View Help

< > C [ http://10.0.50.1

peatop

+ Basic

+ Administration

+ Forwarding

+ Port

+ Power Over Ethernet
+ Trunking

+ Unicast/Multicast MAC
+ GARP/GVRP/GMRP
+ IP Multicast

+ SNMP

+ Spanning Tree

+ VLAN

+ Security

+ ERPS/Ring

+ LLDP

+ PROFINET

+ EtherNet/IP

+ IP Routing

+ Client IP Setting

+ System

r—Basic System Informatic

Model name
Device Description
MAC address
Application Version
Kernel Version
Image Build Info.
Memory

Board Temperature

EHGT508-8PoE

Managed Switch, EHG7508-8PoE
00:60:E9:19:53:8B

an

an

root@bs #1 SMP Tue Jul 26 13:41:07 CST
2016

108780K used, 146900K free, OK buff,
43944K cached

45.75 Centigrade

Figure 5.16 Right Click on the Device List in any Group and Select Open Web = Open on NUM

5.5.2 Telnet

Selecting Telnet will initiate Telnet program.

55.3 Beep

Selecting Beep after right click on the device list will initialize the Beep confirm window, as shown in Figure 5.17 below.
Click an ok button and the device will beep two times.

3 Network Management Utility
File View Help
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This will let device beep.
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5.5.4 Reboot

Selecting Reboot after right click on the device list will initialize the Reboot confirm window, as shown in Figure 5.18 below.
Click an ok button and the device will be rebooted. After the device finished rebooting, the reboot successfully window appears,
as shown in Figure 5.19.

2 Network Management Utility - O X

File View Help

Confirm

This will reboot the device.

Figure 5.18 Select Reboot and the Restart Confirm Window is Launched

EH Network Management Utility - O X

File View Help

Success!

Device reboot success.

Figure 5.19 Notification of the Reboot Success Window

555 Network Setting

Selecting Network Setting after right click on the device list will first Precheck Device SNMP Feature First before Specific
Operations and then initialize the Network Setting window, as shown in Figure 5.20 below. Here is the summary of network
setting which is a bit different from full setting that users can configure through Network Setting of the Top Vertical Icon
Bar.
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B3 Network Management Utility - X

File View Help

< (/I S R O N+ Y =}

Managed Switch, EHG7508-
8PoE(00:60:E9:19:53:8B)

Group A (1 devices) 0 oree

IP Addres:
10.0.50.1

Online Device Type Model IP Address MAC Address Hostname Netmas
255.255.0.0

. Basic/SNMP Managed Switch, EHG7508-8PoE 10.0.50.1 00:60:E9:19:53:8B EHG7508

10.0.0.254
1-1of 1 items

ed DNS servel
0.0.0.0

Alternate DNS server
0.0.0.0
Hostname
EHG7508

Please make sure device username password
setting and SNMP community is correct.

Figure 5.20 Network Setting Window After Right Click on the Device List

You can enable DHCP (Dynamic Host Configuration Protocol) in the first option so that the device can retrieve its network
setting automatically from a DHCP server, which should be available in your LAN. Consult your local network administrator
about DHCP server, if necessary. If the DHCP option is checked, the other settings within this Network Setting window will
be disabled, except Hostname. If you did not enable the DHCP option, the IP Address, Subnet Mask, Default Gateway,
and the Preferred DNS and Alternate DNS addresses will also be active. You can fill in these settings for LAN interface of
the device. After completing all IP network information on this web page, please click on Apply button to allow the
configuration to take effect. Please make sure the device username and password setting and SNMP community is correct.
Then, Network Setting window will be closed, and the status of settings will be notified to the user in the Device List window,
as shown in Figure 5.21 below.

¢ (:) ry < O PeS ’(/b+ Group View
Group A (1 devices) @ Set network settngs success! <
Q X
Basic/SNMP Managed Switch, EHG7508-8PoE 10.0.50.1 00:60:E9:19:53:8B EHGT508 31 31 v
1-1 of 1 items ‘ 1 ‘ 10 / page Goto

Figure 5.21 Notification of the Success Setting in the Device List Window
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5.5.6 Device Advanced Setting

Selecting Device Advanced Setting after right click on the device list will first Precheck Device SNMP Feature First before
Specific Operations and then initialize the Advanced Setting window, as shown in Figure 5.22.

[ Network Management Utility - a X
File View Help
> O F < D o6 AR
105202(00:60:E9:21:85:3E)
5 Authenticati Alarm
Group A (1 devices) (herieaton =
Use
Online Device Type Model IP Address MAC Address Hostname admin
Password
. Basic 106202 10.0.50.100 00:60:E9:21:85:3E System ®

1-1 of 1 items

SNMP Version v2c
Read Communit

public

private

Figure 5.22 Authentication Tab in Advanced Setting Window After Right Click on the Device List

The description of each field in the Side Vertical Menus-Device List-Right Click on Device List-Advanced Setting-
Authentication Tab is shown in Table 5.2 below.

Table 5.2 Description of each field in Device List-Advanced Setting-Authentication Tab

Sections  within | Field Name Description Default VValue
Advance Setting
General admin Username to access the device admin
password Password to access the device Default
SNMP SNMP version Version of SNMP available for the device (v1 and v2c) v2c
Read community The community string for access device statistics (concept Public
similar to a password)
Write community | The community string for config device (concept similar to a private
password)

Figure 5.23 shows when selecting Alarm tab in the Side Vertical Menus-Device List-Right Click on Device List-Advanced
Setting.
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3 Network Management Utility - X

File View Help

< vDF < H 6 B

Managed Switch, EHG7508-
8POE(00:60:E9:19:53:8B)
Group A (1 devices)

Authentication Alarm

Device Type Model IP Address MAC Address Hostname
Name LinkUp LinkDown

] Basic/SNMP Managed Switch, EHG7508-8PoE 10.0.50.1 00:60:E9:19:53:88 EHG7508 Port1
. Port2

1-1 of 1 items
Port3

Port4

Port5
Port6
Port7

Port8

Name On off

Power1

Figure 5.23 Side Vertical Menus-Device List-Right Click on Device List-Advanced Setting-Alarm Tabl

Click check on LinkUp or LinkDown for any ports to receive their notifications. Similarly, click on On and Off option for
any power source to get the notification on its change. Figure 5.24 shows examples of the notification which will appear at the
right bottom corner one at a time when there is a change on the chosen port and power source.

Port6 Link Up & Ports Link Down B bowarT On
Managed Switch, EHG7508-8PoE
IP Address: 10.0.50.1
MAC Address: 00:60:E9:19:53:8B

3-QP,

Managed Switch, EHG7508-8PoE 8-8PoE

IP Address: 10.0.50.1
MAC Address: 00:60:E9:19:53:8B

Figure 5.24 Notification at the Bottom Right Corner for Alarming (Appear One at a Time)
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5.5.7 Port Information

Selecting Port Information after right click on the device list in any group will first Precheck Device SNMP Feature First
before Specific Operations and then initialize the Port Information window, as shown in Figure 5.25. If the software notifies
that SNMP feature fail, user has to enable SNMP first through NMU or web configuration. Please refer to Section 4.1.4 for
detailed settings.

Network Management Utility - X
File View Help

® Check SNMP feature fail.

Please check SNMP of this device is enable.

Figure 5.25 Notification of Failure on SNMP Feature

Figure 5.26 shows device information, real-time traffic in graph, and port status when selecting Port Information in the Side
Vertical Menus-Device List-Right Click on Device List.

Reat-Time Trafi
:

EH7520-4G-4PoE-4SFP - z .
IP Address fa - =
192.168.5.184 Port2

MAC Address

00:60:E9:18:3B:BE

Power1%
Power2 ¥

E

portName portStatus Speed Port Mode inOctets inErrors InUcastPkts inMulticastPkts inBroadcastPkts outOctets outErrors outUcastPkts outMultic  enableStatus

18488

Figure 5.26 Selecting Port Information in Side Vertical Menus-Device List-Right Click on Device List
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5.5.8 Backup and Restore

Selecting Backup and Restore after right click on the device list will initialize Backup and Restore window. User can fill in
a filename and select the destination folder to back-up the device configuration by clicking on SELECT FOLDER button.
Then click on the BACKUP button to backup the configuration. Please make sure that your selected NIC has a real external
IP address by clicking on File > Preferences - General - Network Interface Card. If the backup process is success, the
notification will appear, as shown in .

o 00:60:E9:19:53:8B - Backup and Restore

Backup

Path:

CA\Users\user\AppData\Local\Programs\network-management-utility\backupConfigs\O060E919538B SELECT FOLDER

File Name:

EHG76xx

‘ BACKUP ‘

Restore

File:
SELECT FILE

@ If Backup or Restore fail, please check you select NIC with a real external IP. (File = Preferences —+ General = Network Interface
Card)

Figure 5.27 Backup Part of Vertical Menu-Device List-Right Click on Device List-Backup and Restore

To restore the configuration, user can select a previously saved configuration filename and then click on the RESTORE button
to restore the configuration. Again, please make sure that your selected NIC has a real external IP address by clicking on File
-> Preferences > General > Network Interface Card. Here, new small window will be launched. User need to confirm his/her
requirement to restore the configuration by clicking an OK button, as shown in

Figure 5.28.

o 00:60:E9:19:53:8B - Backup and Restore

Backup
Path:
C\Users\user\AppData\Local\Programs\network-management-utility\backupConfigs\OC || SELECT FOLDER
File Name:
Restore
File:
C:\Users\user\AppData\Local\Programs\network-management-utility\backupConfigs\0060 SELECT FILE
‘ RESTORE ‘
@ If Backup or Restore fail, please check you select NIC with a real external IP. (File = Preferences = General
— Network Interface Card)

Figure 5.28 Restore Part of Vertical Menu-Device List-Right Click on Device List-Backup and Restore
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Figure 5.29 Confirmation Window for the Restore Part

If the restoration process is success, the notification will appear, as shown in Figure 5.30. The device automatically restarts
afterwards, and user will hear a few beeps sound to indicate its restart. The notifications of the device becoming offline and
then online again appear on the bottom right corner.

o 00:60:E9:19:53:8B - Backup and Restore

@ Restore configuration success.

Backup
Path:

C\Users\user\AppData\Local\Programs\network-management-utility\backupConfigs\OC || SELECT FOLDER
File Name:
Restore
File:

C:\Users\user\AppData\Local\Programs\network-management-utility\backupConfigs\0060! SELECT FILE

RESTORE
@ | Backup or Restore fail, please check you select NIC with a real external IP. (File = Preferences — General

— Network Interface Card)

Figure 5.30 Notification on the Success of Configuration Restore
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5.6 Event Log

When clicking on Event Log within the Side Vertical Menus, three sub-tabs are presented: Event, SNMP trap, and Syslog.
56.1 EventTab

Figure 5.31 illustrate what inside the Event tab. User can see history events listed and can sort them according to Time and
SOURCE IP address. Events can be cleared by clicking on a CLEAR button. The history events are listed in a table form,
which consists of the following columns: Time, Source IP, Mode, MAC Address, and Message. Time indicates timestamp
when the event occurred. Source IP, Model, and MAC Address is the IP address, model, and MAC address of the device.
Message displays whether the device is online or offline at time the event occurred.

8 Network Management Utility _ o %
File View Help

>

- Event =~ SNMPtrap  Syslog

Time 2 Source IP £ Model MAC Address Message
2020-05-31 10:56:05 10.0.50.100 05202 00:60:E9:21:85:3E online
2020-05-31 10:56:04 10.0.50.100 05202 00:60:E9:21:85:3E offline
2020-05-31 10:55:24 10.0.50.100 05202 00:60:E9:21:85:3E online
2020-05-31 10:55:22 10.0.50.100 05202 00:60:E9:21:85:3E offline

Figure 5.31 History Events inside the Side Vertical Menu - Event Log - Event Tab

When clicking on a HISTORY button, a new window is launched, as shown in Figure 5.32. Users can filter out unwanted
events by filling in a MAC Address and a Date/Time range of viewing events. Make sure that there is no space when entering
a MAC address. Click REFRESH button to see events that are already filtered out unwanted events.

Event History

Time 2 Source IP 2 Model MAC Address Message
2020-06-03 21:08:05 236.67.1.0 EHG7508 00:60:E9:19:53:88 offline
2020-06-03 20:49:21 236.67.1.0 EHG7508 00:60:E9:19:53:8B online
2020-06-03 19:39:28 236.67.1.0 EHG7508 00:60:E9:19:53:8B offline
2020-06-03 19:22:24 236.67.1.0 EHG7508 00:6 online

Figure 5.32 History Events inside the Side Vertical Menu - Event Log - Event Tab > HISTORY Button
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5.6.2 SNMP Trap Tab

Figure 5.31 illustrate what inside the SNMP Trap tab. User can see history of SNMP Trap by clicking ona HISTORY button,
and clear them by clicking on a CLEAR button.

Network Management Utility

File View Help

>

- Event SNMP trap Syslog

Source IP 2 Up Time 3 GT 2 ST 2 Version 2 Enterprise Community Vark

No data

Figure 5.33 History Events inside the Side Vertical Menus - Event Log > SNMP Trap Tab

The history of SNMP Trap is listed in a table form, which consists of the following columns: Time, Source IP, Up Time, GT,
ST, Version, Enterprise, Community, and Varbinds. The details of each field are described in Table 5.3 below.

Table 5.3 Description of Each Field in the Side Vertical Menus - Event Log - SNMP Tab Tab

Fieldin SNMP Trap Tab | Description

Time Timestamp when the SNMP Trap event occurred.

Source IP IP address of the device

Up time The active time of the device

GT The SNMP generic type

ST The SNMP specified type

Version The SNMP version used at the time of SNMP trap.

Enterprise The SNMP Enterprise OID

Community The SNMP community

Varbinds The variable number of values that are included in an SNMP packet.

When clicking on a HISTORY button, a new window is launched, as shown in Figure 5.34. Users can filter out unwanted
SNMP Trap events by filling in a SOURCE IP Address and a Date/Time range of viewing events. Make sure that there is no
space when entering a SOURCE IP address. Click REFRESH button to see events that are already filtered out unwanted

events.

Trap History

10.0.50.101 2020-05-31 11:49

May 2020

Su Mo Tu We Th

Time 2
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(a) _

Trap History

10.0.50.101 2020-05-31 11:49 ~ 2020-05-31 11:49
May 31 2020 May 31 2020
11 49 11 49
Time 7 12 50 12 50 = Enterprise Community
13 51 13 51
14 52 14 52
15 53 15 53
16 54 16 54
17 55 17 55
18 56 18 56
19 57 19 57
select date

Figure 5.34 History Events Event Log - SNMP Trap Tab - HISTORY Button Selecting Date (a) and Time (b)

Figure 5.35 illustrate what inside the Syslog tab. User can see history of Syslog events by clicking ona HISTORY button, and
clear them by clicking on a CLEAR button.

Network Management Utility — [m] X
File View Help

>

o]
- Event SNMP trap Syslog

Source IP % Up Time % Facility 2 Severity % Tag Message

No data

Figure 5.35 History Events inside the Side Vertical Menus - Event Log - Syslog Tab

Description of each field in Syslog table is shown in Table 5.4 below.

Table 5.4 Description of Each Field in the Side Vertical Menus - Event Log - Syslog Tab

Field in | Description

Syslog Tab

Time Timestamp when the Syslog event occurred.

Source IP IP address of the device

Up time The active time of the device

Facility Type of process that created the syslog event, e.g., kernel, mail system, and security/authorization
Severity Critical level of the information, e.g., emergency and alert

Tag Name of the program or process that generated the message

Message Details of the syslog information

When clicking on a HISTORY button, a new window is launched, as shown in Figure 5.36. Users can filter out unwanted
Syslog events by filling in a SOURCE IP Address and a Date/Time range of viewing events. Make sure that there is no space
when entering a SOURCE IP address. Click REFRESH button to see events that are already filtered out unwanted events.
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Syslog History

Time 3 Source IP

- Up Time 3 Facility 3 Severity % Tag Message

Figure 5.36 History Events insdie the Side Vertical Menus > Event Log - Syslog Tab > HISTORY Button
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5.7 Topology

There are two parts within the Vertical Menus = Topology: 1) Drawing Space and 2) Top Icon bar — Horizontal layer.

5.7.1  Drawing Space

When clicking on the icon of device (e.g., EHG7508 in this picture), the device properties are displayed, as shown in Figure
5.37. If the device icon is in grey colour and mark & appears, the connected device is not ready to be access and reconfigure
its setting. Check in the Device List and see if the device’s SNMP is enabled or not. Please refer to Section 4.1.4 if an SNMP
function is not enabled. If the problem is persisted, user should enable an SNMP function via web interface of the device
instead. Follow the instruction in Section 0 to initialize a web configuration page. Note that when the SNMP is enabled, the
device type changes from Basic to Basic/SNMP.

lanagement Utility

> Group

Show IP Show Model Show Hostname [[] Physics

P Address 10.0.50.1
‘:‘.

-

00:60:E9:19:53:88
10.0.50.1

EHG7508
EHG7508

DHCP
.
Model _______EH

Figure 5.37 History Events inside the Side Vertical Menus - Topology (SNMP Disabled)

After enabled SNMP, the device’s icon becomes green-blue colour and text underneath becomes blue colour, as shown in
Figure 5.38. User can click Show IP, Show Model, and Show Hostname to display text information on IP address, device’s
model and device’s hostname respectively, underneath the device’s icon. When clicking Edit Layout button, new set of icons
will appear: Add Node, Add Link, Save, and Cancel, as
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[% Network Management Utility - o x

File View Help

< Group

O Device List

@ Event Log « 00:60:E9:19:53:8B 10.0.5 Show IP Show Model Show Hostname Physics

¢ Topology 3 CANCEL

=)
T g s
T Managed Switch, EHG7608-8PoE
T —
e Cra—

EHG7508-81d
»

Figure 5.38 Working Space for Drawing a Topology: Side Menus - Topology (SNMP Enabled)

When clicking ADD NODE or ADD LINK button, a new small window is launched, as shown in Figure 5.39. For adding a
new node, user can click anywhere on the working space and enter MAC Address for a new node or click on Virtual Node
option. For adding a link, user can click on two nodes that the new link will be connected.

Add Node X Add Edge X

From 00:60:£9:19:53:8E Port | 1

ﬁ‘ To 00:60:E9:19:53:8B Port | 1

Cancel “ Cancel “
(@) (b)
Figure 5.39 Drawing a Topology in Side Menus - Topology = (a) ADD NODE or (b) ADD LINK

The color coding used in the drawing is:
e  Blue: User defined match with real.
e Black: Real edge and user without defined.
e Dotted Line: User defined but not exist.
e Red-X: Device offline.

There is a Physics option to illustrate moving simulation so that user can see nodes and edges more clearly. This is shown in
Figure 5.40
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Handles the physics simulation,

moving the nodes and edges to show
them dearly.

Show IP Show Model Show Hostname Physics

MAC Address el
_
povce e o |
aewey oot | =)

0080
ManagedS Managed Switch
H 08-S
3

Figure 5.40 Topology drawing example

When clicking on any node or link on the topology’s working space, a DELETE button appears, as show in Figure 5.41 below.
Here, user has a choice to delete any nodes and links. Click on a CANCEL button to go back to EDIT Layout Button.

« 00:60:E9:19:53:8B 10.0.5( Show IP Show Model Show Hostname Physics
» 00:60:E9:19:53:8E

i DELETE X CANCEL

00:60:E9:19:53:8I 00:80:E9:19:53:8B:port1
00:60:E9:19:53:8E:port1

00:60:E9:19:53:8B

10.0.50.101
Managed Switch, EHG7508-8PoE

Figure 5.41 DELETE Button insider the Side Vertical Menus - Topology

If a new device is added in any group using a MAC address, user can view its details in the table inside the Device List.
However, if a newly added device is a virtual node, nothing will be added in the Device List. In this example, a new device is
added using a MAC address in the drawing topology in Group A. Thus, the new device is added in Group A shown in the
Device List, as shown in Figure 5.42 below.
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R Network Management Utility

File View Help

< O T < H O N Group View
R Device List
[ Event Log Group A (2 devices) ©
¢ Topology |O\7x
Basic/SNMP Managed Switch, EHG7508-8PoE 10.0.50.101 00:60:E9:19:53:8B 3.1 3.1
Basic 00:60:E9:19:53:8E
1-2 of 2 items ‘7‘ 10/ page Goto

unGrouped (0 devices)

Figure 5.42 Device List when Adding a New Device using a MAC Address in Topology

Here, if user added node and link and would like to leave to other setting page, click on the Save Button to save the work. The
drawing topology disappears if visiting other setting page without saving your work first. The notification of successfully
saving topology will appear on the top right corner as shown in Figure 5.43.

@ Topology Layout successfully saved.

Figure 5.43 Notification of Successfully Saving of Topology Layout

User can also click on the “EXPORT the image” to save the topology. Select the destination folder to save the image file, as
shown in Figure 5.44.
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- I
File View Help

B3 blobfile;///76a281b2-ad0a-4608-abda-cad7a5377dcd X

<

-« « 1 &> ThisPC > Downloads > v 0| | Search Downloads »

O Device List Organise ~  New folder B= -
= — -
v B ThispC Name Date modified Type Size
O] Emiiley B 30 Objects “ Today (1)
I Desktop | ] b4077d2e-f3ff-4674-973d-63ccchd786ec 6/6/2020 3:15 PM TMP File 6 |

< Topology B Documents  Earlier this week (3)

> ¥ Downloads @3 1554036466 6, 0437 PM PDF File 20

ESTGitUp_assets ComputeRmLtf 6
D Music |1 EHG7508-8PoE.bin 6

0 1:59 PM Microsoft Excel 97..
010:26 AM BIN File 1

&=/ Pictures v Last week (23)

B videos [ secureEndpointManager (14) Application 29
2 Local Disk (C) [ secureEndpointManager (13) Application 29V
= v o< B
File name: | all200606151517 -
Save as type: | All Files (%) v

Save. Cancel

E
osrame ||

~ Hide Folders

00:60:E9:19:53:8B

10.0.50.101
Managed Switch, EHG7508-8PoE

Figure 5.44 Export Image in the Side Vertical Menus - Topology

The export image file is .svg. User can use internet web browser to view it.

5.7.1 Top lcon Bar — Horizontal Layer

Menu icons on the Top Horizonal Icon Bar of Topology in the Side Vertical Menu consists of the followings:
e All Device
e Group X
]

User can click on each group to create a topology and save for each group, as shown in Figure 5.45.
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E% Network Management Utility - [m] X

File View Help

< Group: | All Device

All Device
O Device List

Group A

[E Event Log . 00:60:E9:19:53:88 236.67 Show IP Show Model Show Hostname Physics

< Topology

00:60:E9:19:53:8B

Figure 5.45 Topology in Group A in the Side Vertical Menus - Topology
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6 Top Horizontal Icon Bar - Device List

Menu icons on the Top Horizonal Icon Bar consists of the followings:

>

or ° lcon
Discovery
Firmware Update
Network Setting
Reset to Default
Backup and Restore
Add new group
Group View

6.1 > or < lcon

On the most left is anicon . Here if you click it, it will expand the area of the Side Vertical Menus and show name of

<

each icon, as shown in Figure 6.1 below. If you want to shrink the area of the Side Vertical Menus, click icon as shown

in Figure 6.2.

i3 Network Management Utility - [m] X
File View Help
> (:) T < O [+ & Group View
Group B (1 devices) A
e X
Basic/SNMP Managed Switch, EHG7508-8PoE 10.0.50.101 00:60:E9:19:53:8B 3an 311 v
1-1of 1items ‘:| 10/ page Goto
Figure 6.1 Clicking > Icon to Expand the Area of the Side Vertical Menus
| 8 Network Managemens Uity - o X
File View Help
< C) T (: IO +9 Group View
Q X

Figure 6.2 Clicking < Icon to Shrink the Area of the Side Vertical Menus
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6.2 Discovery

Before discover the connected devices, the working space will be as shown in Figure 6.3 below.

2 Network Management Utility
File View Help

> [ S ORI + t‘:q ) Group View

No Data

Figure 6.3 First-time Launch of Network Management Utility Setup 2.X

When clicking on the discovery icon at the top icon bar, if the SNMP function is on, the pop-up window will appear to notify
that an SNIMP Scan is on process as shown in Figure 6.4.

B Network Management Utility
File View Help

SNMP Scan

Scan Finish!

Figure 6.4 SNMP Scan is Ongoing

After finished it, connected devices will be displayed in the Device List, as shown in Figure 6.5. If these devices are still not
grouped together, number of devices will be showed as unGrouped. If the device is already added to a group, it will be showed
in the device table of that group. Refer to Section 5.2 on how to add a new group and Section $£zR! $RAZ[SIEZIE - on
how to add device into a group. Note that each device can be added to more than one group.
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B2 Network Management Utility — X
File View Help
> vor < H O B Group View
0
= Group A (1 devices) v
< Group B (2 devices) A
(¥ X
Basi NI 0 tch, EHG E " 1"
Bas| 1 3:8E
tems ‘ 1 ‘ age Goto
unGrouped (0 devices)

Figure 6.5 Devices in the Device Table in each Group

Table 6.1 below explains each field in the device table in details.

Table 6.1 Definition of Each Field in the Device Table

Field Description

Online Status of each device: active (green dot) or inactive (red dot)
Device Type Basic or Advanced

Model humber The model number of the found device(s).

IP Address An IP Address of the corresponding device

MAC Address The MAC Address of the device.

Host Name The Host Name of the device.

Kernel The Kernel version of the device

AP Information

The AP information or application version of the device. Note that Atop’s
firmware of a device generally consists of application version and kernel

version.

Access

Indicate whether the device is already accessible ( +~ ) or not ( X). Users
have to join the device in any group first for its accessibility. That is users
have to create a group and add the device to that group first to view it as

accessible.
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6.3 Firmware Update

When clicking on the Firmware Update on the Top Horizonal Icon Bar, the notification box will appear on the top of the
working space of the Device List of Side Vertical Menus, as shown in Figure 6.6 below.

B3 Network Management Utility - X
File View Help
> (:) T < H O ;,q Group View
2 @ Firmware Update
. Select devices and press OK or Cance
& Group A (1 devices) fdev # ' v
< Group B (2 devices) ~
e X
asic/SN g tch, EH E 19:53:8B 1 11 v
a 1 E v

5
]
G

c

Figure 6.6 Click on Firmware Update in the Top Horizontal Icon Bar
After selecting on the device that you want to update the firmware and click OK in the notification box on the top of the

window, a new window is launched as shown in Figure 6.7. Here, user can press BROWSE button and guide through file
directory to select the firmware file (.dld) you want to update.
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Network Management Utilit - X

File View Help

‘ Select a firmware file. . Firmware updating. . Finish!
New Firmware File [ﬁ }-
Model IP Address MAC Address Progress Status
Managed Switch, EHG7508-8PoE 10.0.50.101 00:60:E9:19:53:88 Waiting
Open X
« v 1 <> ThisPC > USBDrive (E) > v|O | search USB Drive (E) »
Organise ~  New folder B~ m @
8 videos A Name Date modified Type size
% Local Disk (C) Work 6/6/2020 8:20 PM File folder
~- DATA (B) ] EHTSXX_K516_A5T6dId 4/18/2019 12:39 AM DLD File 10,285
. USB Drive (E)
< USBDrive ) ¥ < >
File name: |EH75XX_K516_AS16.dId ~] o v

FINISH >

Figure 6.7 Go Through the File Directory to Select the Firmware File (.dld)

Click Open button after selecting the firmware file (.dld). Then the START button will be activated. User can click the START
button at the bottom right corner of the Firmware Update window to start updating.

While waiting for the updating firmware to finish, the progress status is displayed in the Progress field and the update status
is shown in the Status field, as shown in Figure 6.8. If user would like to stop updating the firmware, user can press read STOP
button on right bottom right corner.
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3 Network Management Utility - X

File View Help

° Select a firmware file. . Firmware updating. . Finish!
New Firmware File [ﬁ E:\EH75XX_K516_A516.dIc } BROWSE
Model 1P Address MAG Address Progress Status
Managed Switch, EHG7508-8PoE 10.0.50.101 00:60:£9:19:53:88 — Upload Image
FINISH >

STOP

Figure 6.8 Go through the File Directory to Select the Firmware File (.dld)

After the updating process is finished, the moving progress line reaches the final end, and the status will change to Upload
Success or Upload Fail. Figure 6.9 illustrate an example when the firmware updating process is finished with failure.

2 Network Management Utility _ a %
File View Help

0 Select a firmware file, o Firmware updating. . Finish!

New Firmware File [H 75XX_K516_A516.dI; ] BROWSE

IP Address MAC Address Progress

Managed Switch, EHG7508-8PoE 10.0.50.101 00:60:£9:19:53:88 — Upload Fail(E007)

Figure 6.9 The Firmware Update is Finished with a Failure (Code E007)

After clicking FINISH button, the Firmware Update window will be closed and user will go back to the Device List’s working
space window. In the example, the firmware date is unsuccessful and the error code is E007.
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6.4 Network Setting

When clicking the Network Setting on the Top Horizonal Icon Bar of the Device List, the new window is launched, as
shown in Figure 6.10. Here, on the left side is the Network Setting. User can choose whether to obtain an IP address
automatically or manually. By checking the box in front of DHCP (Obtain an IP automatically), your device will set the IP
address and other parameters automatically. After checking the DHCP option, user does not need to input IP Assign option on
the right side of the window. The START button on the bottom right is activated and ready to begin. Here, the Progress is
shown as 0% before clicking START button.

Figure 6.10 Click Network Setting Icon in the Top Horizontal Bar of the Device List — Automatic Setting

If the checking box in front of the DHCP option is unchecked, user has to manually set the network parameters. Figure 6.11
shows the Network Setting when DHCP option is unchecked.

Proceed to fill in the Netmask, Gateway, Hostname, Preferred DNS server, and Alternate DNS server. Also, user need to put
in the IP address on the right side of the Network Setting, the IP Assign Part as shown in Figure 6.11. There is an IP address
input box named “Start Address”with a CALCULATE button. Press CALCULATE to see if the input IP address is valid. If
yes, the START button at the bottom right of the Network Setting Window will be activated. After Clicking the START button,
information of the device will be presented, including Model, MAC Address, IP Address, and Progress. If the setting is success,
the Progress information will show as a green check sign.
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Network Setting m

* Network setting finish with 0 fai

Model MAC Address IP Address Progress

EHG7508 00:60:E9:19:53:8B @

Figure 6.11 Click Network Setting Icon in the Top Horizontal Bar of the Device List — Manual Setting

6.5 Reset to Default

In order to reset the configuration setting to the default value, user has to first 1) enable an SNMP function of the connected
device, 2) create a group if none is available or if a new group is required for the connected device, and 3) add the device into
a newly created group (refer to Section 5.2). If an SNMP function is not enabled yet, please refer to Section 4.1.4. to enable it.
If the software continue notifies that “(This feature only for device with SNMP support.)” and the “OK” link cannot be clicked
even user already enabled an SNMP function via the Network Management Utility Setup 2.X, user should enable an SNMP
function via web interface instead. User can follow the instruction in Section 0 to initialize a web configuration page.

After the SNMP function is enabled, select connected devices that you want to reset the configuration settings to the factory
default and then press “OK?, as shown in Figure 6.12 below.

% Network Management Utility - [m] X
File View Help

> (:) T < H O ;,q_ Group View

@ Reset To U ault
Select devices and press OK or Cancel.
Group A (1 devices) (This feature only for device with SNMP support) -
Q X
[ ) Basic/SNMP Managed Switch, EHG7508-8P0E  10.0.50.1 0060EQ 195388  EHG7508 311 311 v

1-1of 1items ‘ 1 | 10/ page Goto

unGrouped (0 devices)

Figure 6.12 Select Devices and Click OK to Reset to Default
New window with the details of devices i.e., Model, MAC address, IP address, and the status appears for the user to re-confirm

whether the select device is the correct one, as shown in Figure 6.13. If yes, click START button to start the reset process. Here,
the STATUS is WAITING.

Page 54 of 59



$EaR! (EH [% H] %5 [#R8+ Heading

Network Management Utility User Manual 1,Product Manual ZERZIEEEELLR
RERHISLE ©
@ Reset To Default X
Model MAC Address IP Address Status

Switch, EHG7508-8PoE 00:60:E9:19:53:8B 10.0.50.1 WAITING

START

Figure 6.13 Confirm Window to Reset to Default Setting

After clicking START, when the “reset to default” process is finished, the STATUS is changed to SUCCESS, as shown in
Figure 6.14. Click to in the top right corner to close the window.

@ Reset To Default

Model MAC Address IP Address Status

"

9:53:88 10.0.50.1 SUCCESS

Figure 6.14 Success to Reset to Default Setting

6.6 Backup and Restore

Similar to Reset to Default function icon, user has to first 1) enable an SNMP function of the connected device, 2) create a
group if none is available or if a new group is required for the connected device, and 3) add the device into a newly created
group (refer to Section 5.2). If an SNMP function is not enabled yet, please refer to Section 4.1.4 to enable it. If the software
continue notifies that “(This feature only for device with SNMP support.)” and the “OK” link cannot be clicked even user
already enabled an SNMP function via the Network Management Utility Setup 2.X, user should enable an SNMP function
via web interface instead. User can follow the instruction in Section 0 to initialize a web configuration page.

After the SNMP function is enabled, select connected devices that you want to Backup and Restore the configuration settings
to the factory default and then press “OK?”, as shown in Figure 6.15.
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B3 Network Management Utility
File View Help

< (:) * <: O [+ trﬂ . Group View

@ Backup and Restore

Select devices and press OK or Cancel.
Group A (1 devices) (This feature only for device with SNMP support.)

Online Device Type Model IP Address MAC Address Hostname Kernel Ap Access

. Basic/SNMP Managed Switch, EHG7508-8PoE 10.0.50.1 00:60:E9:19:93:8B  EHG7508 3an 3N v

1-1 of 1 items 10 / page Goto

Figure 6.15 Click Backup and Restore in the Top Horizontal Icon Bar

After clicking OK, the new Backup and Restore window will be launched, as shown in Figure 6.16. Here, the window is
divided to two parts, Devices and Files.

&> Backup and Restore X

Backup START
Model MAC Address IP Address ~ Status

Managed Switch, EHG7508-8PoE  00:60:E9:19:53:8B  10.0.50.1 WAITING

@ If Backup or Restore fail, please check you select NIC with a real external IP.
(File = Preferences — General = Network Interface Card)

Figure 6.16 Backup and Restore Window is Launched after Clicking OK

If users chose to back-up the configuration, select Backup from the drop-down box and click START button. Within this
Devices part, there is the information of the device such as Model, MAC Address, IP Address, and Status. Before clicking
START button, the Backup Status is WAITING. Figure 6.17 shows the Backup and Restore window after finishing the
Backup process and success. The device will be restarted as the user can see the notification window (on the bottom right
corner) for the device going offline and online again. If it is failed, make sure that your selected Network Interface Card (NIC)
is the one with a real external IP address. Go to File - Preferences - General = Network Interface Card to check on it.

Figure 6.18 illustrates what happens when the Backup is failed.
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"2 Y Backup and Restore X

Devices

Backup START

Model MAC Address IP Address ~ Status

Managed Switch, EHG7508-8PoE  00:60:E9:19:53:8B  10.0.50.1 SUCCESS

@ If Backup or Restore fail, please check you select NIC with a real external IP.
(File = Preferences — General = Network Interface Card)

Figure 6.17 Success Backup after Clicking Icon in the Top Horizontal Icon Bar

3 Network Management Utility
File View Help

6 Backup and Restore

Backup

Model MAC Address IP Address ~ Status

Managed Switch, EHG7508-8PoE  00:60:E9:19:53:8B  10.0.50.1 ERROR

Device offline
@ If Backup or Restore fail, please check you select NIC with a real external IP.
(File — Preferences — General — Network Interface Card)

Figure 6.18 Failure Backup after Clicking Icon in the Top Horizontal Icon Bar

By clicking on the device under the Model, MAC Address, IP Address, and Status information, user will see a list of
configuration files that are already backup, as shown in Figure 6.19. User can click red * at the end of each file to remove its
backup configuration.
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& Backup and Restore x

Devices Files
Backup START 0060E919538B_200607133936 X
Model MAC Address IP Address  Status 0060E919538B_200607134200 X

Figure 6.19 Configuration Files that are Already Backup

If user would like to restore the configuration, user has to follow these steps. First, select Restore option from the drop-down
box. Second, click on the device under the Model, MAC Address, IP Address, and Status information. A list of configuration
files will be displayed on the right side of the window. Third, select the configuration file that you want to restore and click
START button. Before clicking START button, the Backup Status is WAITING. Figure 6.20 shows the Backup and Restore
window after finishing the Restore process and success. After the restore is success, there is a couple of beeps sound from the
device and the device will be restarted. The user will see the notification box (on the bottom right of the window) showing that
the device is going offline and online again. Similarly, to the Backup configuration process, if it is failed, make sure that your
selected Network Interface Card (NIC) is the one with a real external IP address.

o Backup and Restore X

Devices, Files
v| 0060E919538B_200603104913
Model MAC Address IP Address ~ Status 0060E919538B_200603110038

# Device offline

@ If Backup or Restore fai, please check you select NIC with a real external IP.
(File — Preferences — General — Network Interface Card)

Figure 6.20 Sucess Restoring the Configuration File
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